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This document describes in detail the steps involved in installing and configuring an Aneka Cloud. It 
covers the prerequisites for the installation, the installation process, setting up and configuring 
Aneka Daemons and Aneka Containers, and running some of the sample applications to test your 
new cloud deployment. 
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1 Introduction  

Aneka is a Cloud Application Development Platform (CAP) for developing and running 

compute and data intensive applications. As a platform it provides users with both a 

runtime environment for executing applications developed using any of the three 

supported programming models, and a set of APIs and tools that allow  you to build new 

applications or run existing legacy code. The purpose of this document is to help you 

through the process of installing and setting up an Aneka Cloud environment. This 

document will cover everything from helping you to understand your exi sting 

infrastructure, different deployment options, installing the Management Studio, 

configuring Aneka Daemons and Containers, and finally running some of the samples to 

test your environment.  

1.1 What is an Aneka Cloud  composed of ? 

An Aneka Cloud is composed of a collection of services deployed on top of an 

infrastructure. This infrastructure can include both physical and virtual machines  located 

in your local area network or Data Centre. Aneka services are hosted on Aneka Containers 

which are managed by Aneka Daemons. An Aneka Daemon is a background service that 

runs on a machine and helps you to install, start, stop, update and reconfigure Containers.  

A key component of the Aneka platform is the Aneka Management Studio, a portal for 

managing your infrast ructure and clouds. Administrators use the Aneka Management Studio 

to define their infrastructure, deploy Aneka Daemons, and install and configure Aneka 

Containers. The figure below shows a high-level representation of an Aneka Cloud, 

composed of a Master Container that is responsible for scheduling jobs to Workers, and a 

group of Worker Containers that execute the jobs. Each machine is typically configured 

with a single instance of the Aneka Daemon and a single instance of the Aneka Container.  

 

 

 

 

 

 

 

 

 

 

Figure 1 ð Management Scenario. 

 

 

 

 

 
Local Area Network or Data Centre  hosting an 

Aneka Cloud 

An administrator using Aneka 
Management Studio to install 

and configure an Aneka Cloud 



Aneka 5.0 Installation and User Guide  

 

 
Copyright © Manjrasoft Pty Ltd.   2 

 

 

The following sections provide detailed instructions on installing and configuring your 

Clouds.  
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Figure 2 - A high-level view of an Aneka Cloud  
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2 System Requirements  

This section describes the hardware and software requirements for creating your cloud 

environment. For a more detailed and accu rate description of the requirements  see 

release notes.  

2.1 Hardware Requirements  

Disk Space: Installation of Aneka using the distributed Microsoft Installer P ackage (MSI) 

require s approximately 75 megabytes of disk space. This installation includes the Aneka 

Cloud Management Studio, binaries for installing Aneka Daemons and Containers, the 

Design Explorer, sample applications and documentation. The Aneka Cloud Management 

Studio is your portal for setting up an Aneka Cloud environment. This involves installing 

the Aneka Daemon and Aneka Containers on remote machines. The Aneka Daemon 

requires approximately 10 megabytes of disk space, and a Container requires 

approximately 20 megabytes. 

NOTE: While the above describes the minimum disk space requirements  for installation, 

running Aneka requires addition al disk space for creating temporary files such as logs , 

storing data files from users that are required for execution, and creating new data output 

files as a result of the execution.  This additional disk space required therefore depends on 

how you plan to use Aneka. See sections below on Storage Service and Execution Services 

for ideal disk space requirements.  

CPU and Memory: The CPU and memory requirements differ based on what you are 

installing. Running Aneka Cloud Management Studio on your machine requires little 

resources and a typical machine with 1 gigabyte of RAM would suffice. Your Master 

Container is responsible for scheduling jobs and keeping track of all the Workers in the 

network. It should ideally run on a powerful machine such as one with a dual-core 

processor and 3 gigabytes of RAM. Your Workers are responsible for executing jobs and a 

similarly c apable machine would be ideal.  

2.2 Software Requirements  

Operating Systems : Aneka is built on Microsoft .Net Framework  4.5 and is capable of 

running on most Windows operating systems. Aneka is certified to run on Windows 7 , 

Windows 8, Windows 8.1, Windows 10 and Windows Server 2012. 

ECMA Runtime  Environment :  Aneka has been designed to run on Microsoft .Net 

Framework 4.5. 

Database: It is highly recommended that you use database persistence in a production 

environment. Memory persistence can be useful for evaluating and testing purposes when 

you need to get a Cloud up and running quickly.  Aneka supports Microsoft SQL Server 2005, 

Microsoft SQL Server 2008 and MySQL 5.1+ for database persistence. 
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3 Installation  

This section assumes that you have a copy of the Aneka distribution with you. If you do not 

have a copy already, you can download the latest version from Manjrasoftõs Website. 

3.1 Installing Aneka  Cloud Management Studio  

Aneka installation begins with installing Aneka Cloud Management Studio. The Cloud 

Management Studio is your portal for creating, configuring and managing Aneka Clouds. 

Installing Aneka using the distributed Microsoft Installer Pac kage (MSI) is a quick process 

involving three  steps as described below.  

3.1.1 Step 1 ï Run the installer package to start the Setup Wizard  

 

 

 

Figure 3 - Welcome Page 

The Welcome Page is self-explanatory and you can proceed by clicking n ext.  

3.1.2 Step 2 ï Specifying the installation folder  

In Step 2 you specify the installation folder. By default Aneka is installed in C: \Program 

Files\Manjrasoft \Aneka.3.0.  

 

http://manjrasoft.com/manjrasoft_downloads.html
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Figure 4 - Specifying the installation folder  

 

3.1.3 Step 3 ï Confirm and start the installation  

 

 

Figure 5 - Confirm Installation  
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At this point you are ready to begin the installation. Click òNextó to start the installation 

or òBackó to change your installation folder. 

 

Figure 6 - Installation Progress  

 

Figure 7 - Installation Complete  
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Once the installation is complete, close the wizard and launch Aneka Management Studio 

from the start menu.  

 

 

 

Figure 8 - Start Menu 
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4 Aneka Cloud Management Studio  

The Aneka Cloud Management Studio is your portal for managing your infrastructure and  

clouds. It provides facilities for defining your underlying cloud infrastructure and creating 

one or more Aneka Clouds on top. It lets you create and manage Aneka user accounts, 

monitor the overall performance of your Cloud, obtain detailed reporting information on 

resource usage, data transfers, billing and application (job)  execution . It also provides 

facilities for troublesh ooting your deployments by allowing you to access and examine 

remote logs.  

4.1 Starting up Management Studio  

 

 

Figure 9 - Starting Aneka Cloud Management Studio for the first time.  

 

When Aneka Cloud Management Studio is started up for the first time youõll be asked to 

create a Remote Repository  for performing remote installations. Setting up a Remote 

Repository  requires selecting a suitable repository type and supplying valid credenti als 

which remote machines can use to connect and download required files.  You may however 

choose to create this repository  at a late time before making remote installations. If no 

repository  is defined, you will be restricted to making local installations only.   
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Figure 10 - Creating a repository for remote installations  

 

If you choose to create a remote repository  at this point,  you will be restricted  to using 

either FTP or Windows File Share. See section 5.3 on Repository Management for more 

details.  

4.2 Shutting down Aneka Management Studio  

When attempt ing to shut down Aneka Management Studio, you will be given the choice of 

saving all configuration data from the current session. It is highly recommended  that you 

save this information and restore it the next time you start using the Management Studio.  

4.2.1 The Configuration File   

The configuration f ile , ManagementStudio.config, contains all information that describes 

your infrastructure, your Clouds, the machine credentials, repositories and authentication 

keys (see section on installing the Master Container) that you defined when using Aneka 

Management Studio. It is recommended that you save this information when you exit 

Management Studio so that you can restore it at a later session, and get up -to-speed with 

your Cloud management without having to redefine all settings again. Some configuration 

inf ormation, such as authentication keys, must be maintained safely if you are to add new 

Containers to your existing Cloud. Losing an authentication key however, is not 

detrimental as you will be able to reconfigure your clouds with a new key.    
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Figure 11 - Request to save configuration data  when closing Management Studio 

 

You can save multiple configuration files, see Figure 12 (a) The configuration file is always 

encrypted before  being writ ten to disk for security reasons. When saving configuration 

data you will be required to specify a password as show in  Figure 12(b). 

 

Figure 12(a) ð Choose location to save configuration file  

 

Figure 12 - Password to encrypt configuration data  

 



Aneka 5.0 Installation and User Guide  

 

 
Copyright © Manjrasoft Pty Ltd.   11 

 

When starting up Aneka Management Studio at a later session, you will be given the choice 

of restoring your configuration data. If you choose to do so, you must re -enter the same 

password you used when saving. 

 

 

Figure 13 - Request to restore configuration data  

4.3 Cloud Explorer - Overview  

The figure below shows the Cloud Explorer in Aneka Management Studio. The Cloud 

Explorer lets you manage your infrastructure ( the physical or virtual machines in your 

network or Data Centre) and the Aneka Clouds that run on top of this infrastructure. It 

provides quick navigation for defining repositories, credentials, viewing the status of the 

machines in your infrastructure, and th e Containers that makeup Aneka Clouds. The 

sections below describe the infrastructure and clo ud management features in Aneka in 

greater detail.  

 

 

Figure 14 ð Cloud Explorer 
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5 Infrast ructure Management  

Your infrastructure is compos ed of the physical and virtual machines in your Local Area 

Network or Data Centre. Before creating an Aneka Cloud you must define your 

infrastructure for hosting the Cloud. The Aneka Cloud Management Studio provides 

facilities for defining and managing your infrastructure.  

5.1 Adding a new Machine  

 

 

Figure 15 - Adding a Machine 

 

The simplest way to represent your infrastructure in Management Studio is to add each 

machine individually. You do this by select ing the Add Machine option in the File menu. 

This approach is simple enough if you have a few machines but can be cumbersome when 

dealing with a large network or Data Centre.  You may alternatively create and import a 

machine list  file as described below.  

5.2 Importing and Exporting Machine Lists  

A machine list file provides a convenient way to import a number  of machines that  define 

your infrastructure . Each machine is represented by a single line in the file in the 

following form : 

 

Machine [IP Address or Name] | Aneka Daemon  Port | Platform | Label  

 

Figure 16 below shows a sample machine list file, all of which are Win dows platforms 

(currently the only supported platform by the Aneka Manageme nt Studio) and labelled 
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according to their location in the network. You may choose to use any label you wish to 

describe your machines in a meaningful way. The ports refer to the Aneka Daemon port 

(whether a daemon has been installed or not). Once you have  created your machine list 

file you can import it by selecting Import Machine List  from the File menu. You may also 

make changes to your infrastructure by adding more machines or removing existing ones in 

Management Studio, and export a new machine list fi le for later use.  

 

 

Figure 16 - A sample Machine List file  

 

5.3 Repository Management  

An Aneka Repository is a location containing all required  binaries for installing Aneka 

Daemons and Containers. When the Aneka Daemon is installed on a machine, the binaries 

for both the Daemon and the Container are downloaded from the selected repository to a 

local repository folder in the target machine  and installed from there.   

When the Aneka Management Studio is installed on a machine for the first time, a Local 

Repository is created by default. The local repository is not accessible over the network 
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and can only be used to perform local installations . That is, for installing the Aneka Damon 

and Containers on the same machine in which the Management Studio is installed.  

 

 

Figure 17 - List of Aneka Repositories for installing Aneka Daemons and Containers  

 

As illustrated  in Figure 9 in the previous section , when the Management Studio is started 

for the first time you are given the opportunity to create a Remote Repository for 

performing remote installations. If you chose No you may create one now if you intend  to 

install Aneka on remote machines.  

Creating a new repository is easy and can be done by selecting Add from the context menu 

for Repositories. The figure below  shows the dialog for adding a new repository. The Name 

field refers to what you would like to call your new repository.  Method refers to the mode 

of access to your repository. The three supported methods include Local, Windows File 

Share, and FTP. The Access URL refers the location of your repository. In the c ase of a 

Local Repository , this would typically refer to Repository folder in your Aneka installation 

directory. In the case of a Windows File Share Repository the URL must be a network 

accessible path, in the following form:   

Format  \ \ <host> \ <drive letter >$\ <path>  

 

Example  \ \ marg \ C$\ Aneka \ Repositor y\  

FTP form-> Path should be:  

Format  <ftp >: //< path >/  

 

Example  ftp://FtpFolder /  

ftp://ftpfolder/
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Local form->Path should be:         

Format  \ \ drive  letter> \ <path>  

Example  C: \ \ AnekaFolder \  

In the case of an FTP repository, the URL is the path to a repository folder in the F TP 

server. Depending on the Method you may also be required to specify a valid  access 

credential that remote machines can use to connect and download the required binaries. 

 

Figure 18 - Creating a new File Share Repository  

 

 

 

 

 

 

When you accept your repository settings by pressing Ok,  the Management Studio will 

begin preparing your Remote Repository. This involves copying the binaries from your local 

repository in the installation folder to the remote location. This may take a few minutes.  

5.4 Machine Credentials  

The Windows Machine Credential s are the credentials you use to access and manage your 

remote machines. These include activities such as installing the Aneka Daemon on remote 

NOTE: We discourage the use of a Windows File Share Repository when 

installing Aneka on a large number of nodes. Remote machines connect 

to the Windows File Share Repository using an IPC$ session.  As Windows 

limits the number of concurrent IPC$ sessions, conne ctions from some 

of the remote machines may fail. You may alternatively install Aneka on 

the remote machines in smaller batches depending on the limit set on 

your Windows machine hosting the repository. We recommend however, 

that you use an FTP repository which poses no such limitations.  

 

file://///drive
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machines, and starting , stopping and uninstalling the Daemon service. These credentials 

must thus have administrative privileges on the target machine.  

When you start up Management Studio for the first time, there will be no credentials 

defined for you by default. Before you starting managing your infrastructure you must 

define one or more credentials. To create a new credential select Add from the context 

menu for Machine Credentials.  This will bring up a dialog requesting the user name and 

password for the credent ial as show in Figure 20.   

 

Figure 19 - A list of Machine Credentials  

 

 

Figure 20 - Creating a new credential  
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As noted earlier, the user account must have administrative rights to the target machine , 

and can either be a local machine account or a domain account. When specifying a domain 

account you must also prefix the domain name  to the user name , for example: 

mydomain\anekaadmin.  

 

 

5.5 Access Denied Machines  

 

 

Figure 21 - Access Denied Machines 

 

When you add or import a list of machines for the first time, they will be listed under 

Access Denied Machines as shown above. This is because the Management Studio does not 

know what credentials to use to connect to the remote machines. In order to associate a 

Machine Credential , select all relevant machines and then select Link Credentials  from 

the context menu. This pops up a dialog allowing you to select one of the credentials that 

you defined earlier, or create a new one if require d as shown below. 
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Figure 22 - Selecting a Credential  

 

 

 

 

Figure 23 - Network Not Accessible 

 

Note that after l inking credentials you may occasionally encounter situations where a 

machine is still not accessible via the network, either because there is a problem with the 

network or the machine is down. Figure 23 shows a list of machines that are not 

accessible. In these situations there is no choice but manually troubleshoot the p roblem 

outside Management Studio. 

5.6 Uninstalled Machines  

An Uninstalled Machine  is one which has no Aneka Daemon running. This implies that 

either Aneka was never installed on the machine or a previous installation was removed. 

The figure below shows a list of Uninstalled Machines after having linked a valid Machine 

Credential . It is  important to realize that the Management Studio can only determine the 

status of a machine after linking to a valid credential. To install Aneka Daemons on 

Uninstalled Machines see section below on Installing the Aneka Daemon .  
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Figure 24 - Uninstalled Machines 

5.7 Installed Machines  

An Installed Machine  is one which has an instance of the Aneka Daemon running. An 

Installed Machine  may also have one or more Container instances running. You may 

perform a number of different activities on an Installed Machine  such as start ing and 

stopping the Aneka Daemon service, installing a Container , updating the binaries, viewing 

the machineõs properties, or uninstalling the Aneka Daemon (and Containers) from  the 

machine. 

Once you have a collection on Installed Machines at your disposal, you are ready to create 

your Aneka Cloud.  
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Figure 25 - Installed Machines 
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6 Installing the Aneka Daemon  

The previous sections looked at the process of defining your infrastructure for creating 

Aneka Clouds. We looked at  adding and importing machines, creating Aneka Repositories 

and Machine Credentials for performing remote installations,  and the various states your 

machines can be in (Access Denied, Uninstalled , Installed ).  

This section will introduce you to the process of installing Aneka Daemons, the 

prerequisite for creating Aneka Clouds. The Aneka Daemon is responsible for managing 

Aneka Containers that make up your cloud. This include s installing new Containers, 

starting, stopping and uninstalling Containers. Aneka Daemons provide the underlying 

management infrastructure for Aneka Clouds. In order to install the Aneka Daemon, select 

the list of Uninstalled Machines that you wish to ins tall the Daemon on, and the n select 

Install  from the context menu as shown in the figure below.  This brings up the Aneka 

Daemon Installation Wizard  as shown in the Figure 27. 

 

 

Figure 26 - Installing the Aneka Daemon on a group of machines  

 

6.1 Step 1 ï Repository and Port  Configuration  

The Wizard will automatically probe  all selected machin es on start up to find if the 

default port ,  9000, is free . If the port in any one of the machines is not free, as a result of 

being used by another program, you must either ensure that it becomes f ree, or change 
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the port number for the Aneka Daemon. If you wish to verify whether your new port i s free 

on all target machines , press the Probe button again.  

After selecting a valid port, you must select a suitable repository to install the Daemon 

from. As mentioned previously, a Local Repository is only valid for performing local 

installations. When performing remote installations you must select one of the valid File 

Share Repositories you defined earlier. If all settings are correct you may now click Next 

to view a summary of the installation. If either your port or repository selection is 

incorrect the Wizard will inform you of this and prevent you from proceeding to the next 

step.  

 

 

Figure 27 - Aneka Daemon Installation Wizard  

6.2 Step 2 ï Review Summary  and Install  

Figure 28 shows a summary of the settings prior to installing the Daemon. If you are 

satisfied with the installation settings you may start the installation by pressin g Finish. To 

change the installation settings press Previous.  
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When you press Finish the Wizard will begin installing the Aneka Daemon on all of the 

selected machines. This process might take a few minutes depending on the number of 

machines selected. When the Daemons are installed on the target machines they are 

automatically started up as shown in Figure 29. You might occasionally notice some of the 

machines being marked with a warning icon. This is because the Management Studio is 

unable to determine the status of the Aneka Daemon on those machines, the most 

common reason being that the Daemon service might  have not finished starting up. Select 

Refresh in the View menu after completing the installation in order to see the proper 

status as shown in the figures below.  

 

 

Figure 28 - A summary of the Aneka Daemon installation  settings 

 










































































